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How to Use This Guide 

This document is intended to provide a simple manual for using I-X Process Panels. 

Section 1 provides an introduction to the I-X process panel and supporting panels together 
with instructions of how to run these panels. This section also provides pointers to simple 
demonstrators of process panels as well as a quick-start guide for those eager to try the I-X 
tools quickly. Section 2 describes the use of I-X Process Panels. Section 3 describes the 
context of I-X process panels and its individual supporting tools. 

 

For more details, see also the I-X Web Pages at www.i-x.info that contain overviews, 
introductions, and pointers to further documents and sources of information, including the 
following:  

• The I-X Demonstrators, e.g. I-Demo-Basic and I-Demo-Cooperation; 

• I-X Domain Editor Guide on how to use the I-DE tool; 

• I-X Configurer’s Guide on methods for building I-X applications. This guide 
describes the steps necessary to move beyond a basic use of the I-X tools by 
tailoring them for particular applications; 

• I-X Notes with details on a variety of issues; and  

• The Javadoc-generated documentation of the I-X system. 

In future, we expect to also provide 

• I-X Developer’s Guide on how to further adapt I-X to specific requirements. 

• I-X Modeller’s Guide on how to produce high-quality domain models that are suitable 
for I-X applications. 
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1 Introducing I-X Process Panels (I-P2) 

An I-X Process Panel (I-P2) is designed to act as a workflow, reporting and messaging ‘catch 
all’ tool for its user.  It can act in conjunction with other panels for other users if desired. An I-
X process panel therefore  

• Can take ANY requirement to: 

o Handle an issue; 

o Perform an activity; 

o Maintain a constraint; and  

o Note an annotation.  

• Deals with these above functions via: 

o Manual (user) activity through its GUI; 

o Internal capabilities through I-X and other compatible tools;  

o External capabilities (invoke or query) through I-X and other compatible 
tools; 

o Reroute or delegate to other panels or agents (e.g. using its escalate, 
pass or delegate messaging functions); and  

o Plan and execute a composite of these capabilities (e.g. through the 
expand capabilities of I-X).  

• Receives and sends reports and messages, and, where possible, interprets them 
to: 

o Understand the current status of issues, activities, constraints and 
annotations; 

o Understand the current world state, especially the status of process 
products (i.e. outputs generated by the process in the panel); and  

o Help control the current situation (through communication, follow-up and 
execution of appropriate processes).  

• Copes with partial knowledge (by making use of whatever  knowledge is 
available).  

 

Three example I-X panels are shown in the Figure 1, 2 and 3. These panels are taken from a 
demonstration of agent systems within a military Coalition context that is a part of the 
Coalition Agents eXperiment, the CoAX project (Allsopp et al. 2001; 2002). 

 

An I-X Process Panel supports a user and their collaborators in selecting and carrying out 
processes and creating and modifying process products.  Both processes and process 
products are abstractly considered to be made up of Nodes (i.e. a node may be an activity in 
a process, or a component of a process product). A node may contain sub-nodes. They can 
therefore be described using a hierarchical structure.  These nodes may be restricted by their 
own local Constraints; and may relate to each other via a set of shared constraints of various 
kinds.  An Issue may be associated with processes or process products to represent 
unsatisfied requirements, problems raised during analysing, critiquing or process execution.  

Processes and process products in I-X are defined in the conceptual framework of <I-N-C-A> 
(i.e. the Issues – Nodes – Constraints – Annotations) model that is used to describe the 
activities, considerations and progression of synthesising artefacts (Tate, 2000; 2003).  
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Figure 1: Screen Capture of the Messenger Tool of I-X 

 

 
Figure 2: Screen Capture of I-X Process Panel for Coalition Force Commander 
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Figure 3: Screen Capture of I-X Process Panel for Maritime Component Commander 

1.1 Running an I-X Process Panel 
You can run a stand-alone I-X process panel or several panels that communicate with each 
other. The I-X Demonstrators illustrate the use of such panels. The quick start guide below 
explains how to run an empty, stand-alone process panel (for a quick look). Section 1.1.3 
describes how to run a process panel with an existing Jabber account. 

 

1.1.1 I-X Demonstrators 
As a part of standard I-X distribution, there are a few demonstrators of simple I-X process 
panel applications that show how process panels may be used:  

• I-Demo-Basic, described in <ix-base>/doc/IX-IDemo-Basic.pdf, gives a first look and 
provides instructions on how to use a process panel;  

• I-Demo-Cooperation, described in <ix-base>/doc/IX-IDemo-Coop.pdf, illustrates the 
use of process panels for communication purposes.  

Follow the instructions in the corresponding documents for those demonstrators and see I-X 
Process Panels in action. 

 

1.1.2 A Quick Start Guide 
The quickest way to start up and run an I-X Process Panel is to double-click on the I-X Jar 
file, <ix-base>/ix.jar. This will invoke a panel in stand-alone mode. Of course, in order to take 
the full advantage of I-X as a collaborative environment, you will eventually want to 
communicate with other panels. For this, see I-Demo-Cooperation or the next sub-section. 

After you have double-clicked on the I-X Jar file, a window will come up to allow you to adapt 
the panel. All fields should already be filled with the defaults to bring up a simple panel, so 
just click “Ok”. This should start a basic I-X Process Panel.   
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You are now ready to explore the different I-X facilities: 

• From the “New” menu you can create new issues, activities, constraints and annotations, 
and see these displayed on the panel (and once you’ve created a plan, save this through 
the “File” menu).  

• From the “Tools” menu you can start a Domain Editor, and try creating your own process 
models. You can start a simple HTML Viewer for accessing directly local I-X HTML 
resources. You can use the I-Space tool to enter the names of other agents and your 
relationships with them (and see how this affects your options for handling the issues and 
activities on the main process panel). If you are logged on to a Jabber server and you 
know the Jabber Identification (JID) of another online user (who may be running a 
conventional Jabber client, rather than an I-X panel) you can try communicating with them 
using the Messenger tool by typing their JID into the “Recipient” field.  Add some text to 
the “Compose Message” field, and clicking “Send”. If you do not know any other online 
users, you can still test your connection by sending a message to ix-
test@jabber.org - this is an agent that simply responds with an acknowledgment for 
any message it receives. 

• The options in the “Help” menu provide more information about using I-X. 

This way, soon you’ll learn more about I-X and how to tailor it to your own applications. 

 

1.1.3 Jabber Start Guide 
This section describes how to run an I-X Process Panel using the Jabber instant messaging 
protocol for communicating with other users’ panels. To run a Jabber process panel: 

1. Double-click the ix.exe icon (MS Windows users); or the IX-Mac icon (Apple Mac 
users); or from a command-line prompt, call the ix application script (Unix, Linux 
and Mac OS X users).  This should start a basic I-X Process Panel. 

 
Figure 4: Jabber Login Screen 

2. Along with the panel, a “Jabber login” window should now appear (pictured below): 

• If you wish to simply run a stand-alone panel, you should click “Cancel”. 

• If, on the other hand, you want to communicate with other I-X panels and you 
already have a valid Jabber username and password, you should enter these 
details, along with the name of the Jabber server on which this name is 
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registered, and then click on “Login”. If successful, the name of your panel should 
be updated to show your username. 

• Finally, if you want to communicate but do not have a username, then you can 
attempt to create a new account through this window. To do this, you need to 
type in the name of a Jabber server that allows new accounts to be created 
(jabber.org, for example) and enter a new username and password (taking 
care to remember your choices!) and tick the “New account” box.  Now click on 
“Login”: if the new account has been successfully created, the name of your 
panel should now be updated with your new username.  However, if the attempt 
fails (perhaps because the username you chose is already in use), you will see 
an error message, and will be prompted to try different values.  (To learn more 
about Jabber Instant Messaging see http://www.jabber.org/.) 

3. Explore the different I-X facilities as for the quick start in the previous sub-section. 
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2 Using an I-X Process Panel 

 
Figure 5: Schematic Design of I-X Panels 

 

An I-X Process Panel (I-P2) (shown schematically above) contains a number of sub-panels 
that describe: 

• A set of issues to be handled. 

• A set of activities to be performed. 

• Current state information reflecting the current set of constraints to be respected. This 
includes the status of a range of process products being created or manipulated by 
the processes. 

• Annotations in the form of keyword=value pairs. 

The panel supports its user in handling issues, deciding on a course of action performing 
activities, maintaining awareness of the current execution state, constraints, process 
products, etc., and making annotations of various kinds. 

 

 
Figure 6: Entries and Colour Codes of I-X Menus 

Entries on panels can be expanded using information stored in the process library that is 
retrievable through the Process Panel. These entries may also be passed between panels, 
e.g. through I-X’s delegation and escalation facilities.  
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Right click on an entry to get a context-sensitive menu that describes operations you can 
perform on it.  Where relevant, this includes the ability to pop-up a window with more details 
of the entry, or to expand or contract the display of some levels of hierarchically specified 
activities, to send information about the entry to the Messenger tool for sending on to others 
(perhaps in a modified form), etc. 
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3 Context and Tools for I-X Process Panels 

A Tools menu is available to make accessible the following facilities: 

• A domain or process library editor to view, edit or add to the list of process 
descriptions which may be used to ‘expand’ process entries on the process panel (I-
DE, see section 3.1.2).  

• A tool to view and change the relationships of the current panel to others (I-Space,  
see section 3.2). 

• An instant messaging or ‘chat’ tool to communicate in free format or the encouraged 
<I-N-C-A> structured forms with other I-X Process Panels and other systems 
(“intelligent messaging” or “semantically augmented messaging”: Messenger, see 
section 3.3). 

• Other tools can be added to I-P2, for example, the Map Tool that enables 
representative domain objects to be displayed and manipulated in a geographical 
space, as the application demands. 

• In addition, an AI planner is available to automatically construct alternative ways of 
performing current activities and achieving objectives (I-Plan, see section 3.4). 

 

 
Figure 7: A combined use of tools in an I-X Application 

3.1 Editing Domains 
 

The process model descriptions used by I-X Process Panels are kept in domain libraries.  
These can be loaded when a panel is started, and can be augmented dynamically by the user 
of the panel.  There are two editing tools available to I-X users to help them create and 
manage their own domains: the Simple Editor and the I-X Domain Editor (I-DE). These are 
introduced below. The current editor can be invoked from a Process Panel by selecting Tools 
> Domain Editor. 
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3.1.1 Basic Editing: A Simple Domain Editor 
The process panels contain a simple, form-based domain and process editor (shown above).  
This allows simple task breakdowns to be specified along with a temporal constraint that the 
sub-steps should be either sequentially ordered or performed in parallel. 

 
Figure 8: The Simple Domain Editor 

3.1.2 A More Sophisticated Editor: I-DE 
To create richer descriptions of process models and allow more sophisticated management of 
domain libraries, the user of I-X may want to use I-DE.  I-DE is a more powerful domain and 
process editor that it offers multiple perspectives and views onto a model.  In addition to 
editing process models, I-DE can also be used to model other aspects of the domain, such as 
object classes. It also provides different styles of visualisation of the models. Appendix A 
describes how it can be replaced by the Simple Editor for applications where adequate.  I-DE 
is also available as a stand-alone application for the maintenance of domain and process 
libraries.)     

 

3.1.3 Using XML and Text Editors  
There is a further option for users without access to either the Simple Editor or I-DE, or those 
who wish to make simple amendments to their models. The fact that the domain models 
created by these tools are saved in XML files means that they may be modified using an XML 
editor, e.g. Microsoft’s XML Notepad, or a standard text editor. Example screen captures of 
these tools are provided in Figure 10 and 11. For more information on XML Notepad, see 
http://msdn.microsoft.com/xml/notepad/intro.asp.   
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Figure 9: I-DE, An Advanced Domain Editor 

 
Figure 10: Using a standard text editor for an XML Document 
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Figure 11: A Screen Capture of XML Notepad 

 
Figure 12: The I-Space Tool 

3.2 The I-Space Tool 
The I-Space tool allows for the management of the organisational relationships between the 
current panel (referred to as “me”) and other panels, agents and external services.  New 
agent names can be typed into the text field at the bottom. Existing agents or panels can have 
their relationships altered.  The Commit button is used to inform the process panel of any 
addition or changes to the set of relationships with existing entries.  You can undo any 
changes made to the I-Space table that have not been committed already. 

The relationships defined affect Action menu items for issues and activities of the 
corresponding Process Panel. It also determines how issues and actions may be passed 
around, e.g. through escalation or delegation.  The relationships and the corresponding 
Action menu items are as follows: 
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Table 1: Action Menus in the Process Panel in relation to organisational relationships 
specified in the I-Space Tool 

Relationship Action Menu Item 

Superior Escalate to (with report back) 

Peer Pass to (with report back) 

Subordinate Delegate to (with report back) 

Service Invoke (with report back) 

Contact None 

None None 

 

Providing a description of the verbs associated with any agent (via the Capabilities tab) can 
be used to selectively show the agent in the Action menu only for the specified verbs.  If no 
verb association is provided, it is assumed that all Superiors, Peers and Subordinates can 
handle any item (i.e., described using any verb).  It is expected that an external-capabilities 
description is given for a Service or it will not appear on the menu at all. 

For some communications strategies, extra menu options are added into the I-Space tool to 
provide services and facilities relevant to the specific nature of the communications strategies 
in use. 

3.3 The I-X Messenger Tool 
The I-X Messenger tool is used to compose and send messages to other panels and agents.  
Messages can be designated issues, activities (these with corresponding priorities) or 
constraints, or, less formally, simple ‘chat’ messages. The tool also shows any chat 
messages received from other agents (in the Transcript window).  You can send messages to 
your own panel (“me”) and there is also a simple group sending facility (which will be 
expanded in future releases).  

 

 
Figure 13:  

The I-X Messenger Tool 
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3.4 The I-Plan Tool 
The facilities available in the I-X Process Panels provide context sensitive options for the 
handling of issues (such as the achievement of stated objectives), the performance of 
activities, and the satisfaction of constraints.  A simple AI Planner (I-Plan) is available as a 
tool to propose alternative ways in which activities on the panel can be expanded. 

 

 
Figure 14: The I-Plan Tool 

I-Plan can perform hierarchical partial-order composition of plans from a library of plan 
schemas or Standard Operating Procedures (SOP).  This library can be augmented during 
planning either using a simple ‘activity details’ interface to add in specific ways to expand a 
given activity (intended for users familiar with the application domain but not AI planning 
techniques) or with a more comprehensive graphical domain editor (I-DE – see section 3.1.2). 
Grammars and lexicons for the activities in the domain and the objects manipulated by them 
are built automatically during domain editing to assist the user.  

 
Figure 15: Plan generation using the I-Plan Tool 

 

I-Plan can check that (pre-)conditions are satisfied or introduce activities to achieve them, it 
can select consistent bindings for a set of variables in the current plan, and can check or 
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impose temporal constraints between activities. I-Plan cannot currently reason about 
resources, spatial constraints, or metric time constraints. 

Future developments of I-Plan will provide more assistance with a ‘How do I do this?’ option 
under the Action menu which will be able to account for other concurrent items on the panel, 
and account for mutual satisfaction of open variables, unsatisfied world state conditions and 
other constraints. I-Plan will also be extended to provide a plan repair capability should 
activities fail during execution, or the environment dynamically change in unforeseen ways. 
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